Copyright 2009 AMICAS, Inc. All rights reserved.

Use, duplication, or disclosure by licensee is subject to restrictions as set forth in the AMICAS, Inc. contract. Information contained in this document is subject to change without notice and does not represent a commitment on the part of AMICAS, Inc. The software and processes described in this document are furnished under the contract or nondisclosure agreement. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, for any purpose other than the purchaser’s personal use without the written permission of AMICAS, Inc.

This document contains proprietary information of AMICAS, Inc. The contents are exempt from disclosure to the public under the Freedom of Information Act 35, U.S.C. 552 (6)(4) and unlawful disclosure thereof is a violation of the Trade Secrets Act, 18 U.S.C. 1905. Public disclosure of any information contained herein shall not be made without prior written permission of AMICAS, Inc.

AMICAS is a registered trademark or trademark of AMICAS, Inc.

All other names and products are trademarks or registered trademarks of their respective companies.

RESTRICTED RIGHTS LEGEND:

Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013. AMICAS, Inc.

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>9/17/09</td>
<td>A</td>
<td>Initial Release for 5.5</td>
</tr>
</tbody>
</table>
# Table of Contents

Preface ......................................................................................................................................................... ii

1. Introduction...................................................................................................................................... 1-1

2. Special Bulletins.............................................................................................................................. 2-1
   2.1. Word 2007 Supported ............................................................................................................. 2-1
   2.2. Windows Vista Supported ..................................................................................................... 2-1

3. System Requirements..................................................................................................................... 3-1
   3.1. General System Workstations ............................................................................................... 3-1
       3.1.1 Hardware .......................................................................................................................... 3-1
       3.1.2 General Software ................................................................................................................. 3-1
       3.1.3 Anti-virus Configuration ........................................................................................................ 3-1
       3.1.4 Pop-up Blocking Software .................................................................................................... 3-2
   3.2. Transcription/Physician Review Workstation ...................................................................... 3-2
       3.2.1 General Hardware ................................................................................................................ 3-2
       3.2.2 Digital Dictation Hardware.................................................................................................... 3-2
       3.2.3 General Software ................................................................................................................. 3-2
       3.2.4 Anti-virus Configuration ........................................................................................................ 3-2
       3.2.5 Pop-up Blocking Software .................................................................................................... 3-3
       3.2.6 Configuring the AutoCorrect Options in Microsoft Word ...................................................... 3-3
           a. Word 2003 ............................................................................................................................ 3-3
           b. Word 2007 ............................................................................................................................ 3-5
       3.2.7 Configuring Bookmarks for Users who Create or Edit Templates ....................................... 3-8
           a. Word 2003 ............................................................................................................................ 3-8
           b. Word 2007 ............................................................................................................................ 3-9

4. General Configuration Procedures................................................................................................ 4-1
   4.1. Internet Explorer 6 Configuration Settings .......................................................................... 4-1
   4.2. Internet Explorer 7 Configuration Settings .......................................................................... 4-8
   4.3. Configuring How Word Documents Are Displayed........................................................... 4-20
       4.3.1 Configuring Word 2003 ...................................................................................................... 4-21
       4.3.2 Configuring Word 2007 ...................................................................................................... 4-23

5. Optional Configuration Procedures .............................................................................................. 5-1
   5.1. Configuring the Windows Taskbar in Windows XP ............................................................ 5-1
   5.2. Making a Desktop Shortcut to AMICAS RIS ......................................................................... 5-3

6. Validating and/or Removing the Active X Version ................................................................. 6-1
   6.1. Internet Explorer 6 Instructions .............................................................................................. 6-1
   6.2. Internet Explorer 7 Instructions .............................................................................................. 6-3
   6.3. Microsoft Vista Instructions .................................................................................................. 6-7
Preface

The AMICAS RIS 5.5 Workstation Configuration Guide contains the procedures for configuring the various client components of the AMICAS RIS application, Release 5.5.

Purpose and Audience

This document is intended to serve as a procedure manual for the Administrative staff responsible for maintaining the system.

Other AMICAS RIS Documentation

In addition to this document, the following documents describe your AMICAS RIS system and how to use it:

- AMICAS RIS 5.5 Portal User’s Guide
- AMICAS RIS 5.5 Admin Guide
- AMICAS RIS 5.5 Report Generator Product Information
- AMICAS RIS 5.5 Report Generator User Installation & Configuration Guide
- AMICAS RIS 5.5 HL7 Interface Guide
- AMICAS RIS 5.5 Release Notes
- PowerScribeSDK V3.0 Software Installation/Upgrade and Configuration
1. Introduction

The AMICAS RIS Workstation component is installed automatically on the client machine via an ActiveX download when the user accesses the Web server. Once the ActiveX component is installed, Internet Explorer will need to be configured on the client machine in order for all the functionality to be available.

You must have local administrator privileges on the workstation in order for the ActiveX component to be downloaded and installed.
2. Special Bulletins

2.1. Word 2007 Supported

Release 5.5 of AMICAS RIS has been validated with Word 2007, SP2.

2.2. Windows Vista Supported

Windows Vista is now commercially available. Release 5.5 of AMICAS RIS has been validated with Windows Vista, Business Edition (Service Pack 1). However, it has not been validated for use with Report Generator and PowerScribe.
3. System Requirements

The following describes the recommended hardware and software requirements for both general system workstations and transcription/physician review workstations.

You must have local administrator privileges on your workstation for the Word Active X and Flash components used by AMICAS RIS to be installed.

3.1. General System Workstations

3.1.1 Hardware

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Clock Speed</td>
<td>2.0 GHz or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>1 GB or higher</td>
</tr>
<tr>
<td>Network Card</td>
<td>10/100 NIC Card</td>
</tr>
<tr>
<td>DVD Player</td>
<td>DVD Player</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>40 GB or higher</td>
</tr>
<tr>
<td>Monitor</td>
<td>17&quot; or larger</td>
</tr>
</tbody>
</table>

3.1.2 General Software

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows XP Professional Service Pack 2 or 3; Windows Vista (Business Edition), Service Pack 1</td>
</tr>
<tr>
<td>Web Browser</td>
<td>Internet Explorer version 6.0 SP2 or 7.0</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>2003 or 2007 (SP2)</td>
</tr>
<tr>
<td>Antivirus</td>
<td>Full-featured (i.e., corporate or enterprise) version of an industry-standard anti-virus program.</td>
</tr>
</tbody>
</table>

3.1.3 Anti-virus Configuration

Any anti-virus software running on a workstation should be configured as follows:

- Full system scans should not be scheduled during work hours as this can result in an unacceptable degradation in the performance of the AMICAS RIS product.
- If your anti-virus software supports scanning scripts (i.e. Java, VB, Perl), this must be disabled.
- If the anti-virus software supports CPU usage limit configurations, CPU usage should be no more than 20% of available CPU.
- All files in the report upload directory should be excluded from anti-virus scans. By default this is the user temp directory for the administrative login account but can be configured on a site-by-site basis (typically C:Documents and Settings\[username]\Local Settings where [username] is the name of the user logging into the workstation).
3.1.4 Pop-up Blocking Software

The AMICAS RIS application displays certain information in separate pop-up windows. If pop-up blocking software is installed on the Workstation, it should be configured to permit pop-up windows from the AMICAS RIS web server.

3.2. Transcription/Physician Review Workstation

3.2.1 General Hardware

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU Clock Speed</td>
<td>2.0 GHz or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>2 GB or higher</td>
</tr>
<tr>
<td>Network Card</td>
<td>10/100 NIC Card</td>
</tr>
<tr>
<td>DVD Player</td>
<td>DVD Player</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>40 GB or higher</td>
</tr>
<tr>
<td>Monitor</td>
<td>17” or larger</td>
</tr>
</tbody>
</table>

3.2.2 Digital Dictation Hardware

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microphone</td>
<td>Dictaphone USB Scanner or Non-scanner Microphone (1 per Physician Workstation)</td>
</tr>
<tr>
<td>Headset</td>
<td>Dictaphone Headset (1 per Transcription Workstation)</td>
</tr>
<tr>
<td>Footpedal</td>
<td>Dictaphone Serial Foot Pedal (1 per Transcription Workstation)</td>
</tr>
</tbody>
</table>

3.2.3 General Software

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows XP Professional Service Pack 2 or 3; Windows Vista (Business Edition), Service Pack 1</td>
</tr>
<tr>
<td>Web Browser</td>
<td>Internet Explorer version 6.0 SP2 or 7.0</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td>Word 2003 or Word 2007 (SP2)</td>
</tr>
<tr>
<td>Spellchecker</td>
<td>Stedman’s Spellchecker</td>
</tr>
<tr>
<td>Antivirus</td>
<td>Full-featured (i.e., corporate or enterprise) version of an industry-standard anti-virus program.</td>
</tr>
</tbody>
</table>

3.2.4 Anti-virus Configuration

Any anti-virus software running on a workstation should be configured as follows:

- Full system scans should not be scheduled during work hours as this can result in an unacceptable degradation in the performance of the AMICAS RIS product.
- If your anti-virus software supports scanning scripts (i.e. Java, VB, Perl), this must be disabled.
- If the anti-virus software supports CPU usage limit configurations, CPU usage should be no more than 20% of available CPU.
- All files in the report upload directory should be excluded from anti-virus scans. By default this is the user temp directory for the administrative login account but can be configured on a site-by-site basis (typically C:\Documents and Settings\[username]\Local Settings where [username] is the name of the user logging into the workstation).

- If you are using Voice Capture, the following file types should also be excluded from all anti-virus scans (including real-time and full system scans):
  - .wav
  - .grm
  - .usr
  - .sig
  - .svc
  - .nvc
  - .voc
  - .enh
  - .ini
  - .per
  - .dvc
  - .lst
  - .known
  - .log
  - .svc
  - .nvc

### 3.2.5 Pop-up Blocking Software

The AMICAS RIS application displays certain information in separate pop-up windows. If pop-up blocking software is installed on the Workstation, it should be configured to permit pop-up windows from the AMICAS RIS web server.

### 3.2.6 Configuring the AutoCorrect Options in Microsoft Word

Before transcribing, it is necessary to modify some AutoCorrect options in Microsoft Word.

a. **Word 2003**

   Perform the following steps to configure Microsoft Word:

   2. Click on **Tools** in the menu bar and **AutoCorrect Options...**, as shown below:

   ![AutoCorrect Options](image)

   **Figure 3-1: AutoCorrect Options**

   The **AutoFormat Options** window displays.
3. Click on the **AutoFormat As You Type** tab, as shown below:

![Figure 3-2: AutoCorrect Options Window](image)

4. Uncheck the **Hyphens (--) with dash (–)** checkbox, as shown below:

![Figure 3-3: AutoFormat As You Type Tab](image)
5. Click on the **AutoFormat** tab and uncheck the **Hyphens (--) with dash (–)** checkbox, as shown below:

![AutoFormat Tab](image)

**Figure 3-4: AutoFormat Tab**

6. Click on the **OK** button.

**b. Word 2007**

Perform the following steps to configure Microsoft Word:

2. Click on the **Office** button and the **Word Options** button, as shown below:

![Figure 3-5: Word Options Button](image)

The **Word Options** window displays.

3. Click on the **Proofing** option on the left-hand menu, as shown below:

![Figure 3-6: Proofing Option](image)
4. Click on the **AutoCorrect Options…** button, as shown below:

![AutoCorrect Options](image)

The *AutoCorrect* window displays.

5. Click on the AutoFormat As You Type tab.

6. Uncheck the **Hyphens (--) with dash (\textendash) option**, as shown below:

![Hyphens (--) with dash (\textendash) Option](image)

7. Click on the **AutoFormat** tab.

8. Uncheck the **Hyphens (--) with dash (\textendash) option**, as shown below:

![Hyphens (--) with dash (\textendash) Option](image)

9. Click on the **OK** button.
3.2.7 Configuring Bookmarks for Users who Create or Edit Templates

Users who create or edit templates should ensure bookmarks are visible before making changes. This is done from within Microsoft Word.

a. Word 2003

Perform the following steps to configure Microsoft Word 2003:

2. Click on **Tools** in the menu bar and then select **Options**…

   *The Options window displays.*

3. At the Options window, click on the **View** tab and make sure the **Bookmarks** option is selected, as in the following example:

![Figure 3-10: Selecting the Show Bookmarks Option](image)

4. Click the **OK** button to close the Options window.
b. Word 2007

Perform the following steps to configure Microsoft Word 2007:

2. Click on the Office button and the Word Options button.
   
   The Word Options window displays.

3. At the Word Options window, select the Advanced option on the left-hand menu.
   
   The Advanced Word Options window displays.

4. Make sure the Show Bookmarks option is selected, as in the following example:

   ![Advanced Word Options Window](image)

   3-11: The Advanced Word Options Window

5. Click the OK button to close the Options window.
4. General Configuration Procedures

4.1. Internet Explorer 6 Configuration Settings

Perform the following steps on all workstations:

1. Start Internet Explorer.

2. Click on Tools on the menu bar and select Internet Options, as shown below:

   ![Figure 4-1: Selecting Internet Options](image)

   *The Internet Options window opens with the General tab displayed.*

3. If you are upgrading to Release 5.5 from a previous version of AMICAS RIS, clear the Internet Explorer cache by clicking on the Delete Cookies, Delete Files, and Clear History buttons, as shown below:

   ![Figure 4-2: Clearing the Internet Explorer Cache](image)

   *You do not need to select the Delete all offline content option, if available.*
4. In the **History** section, set the **Days to keep pages in history** to 1 and click on the **Settings** button in the **Temporary Internet files** section, as shown below:

![Figure 4-3: Days to Keep Pages in History](image)

*The **Settings** window displays, as shown below:*

![Figure 4-4: Settings Window](image)

5. Click on the **Automatically** radio button under the **Check for newer versions of stored pages** section and click on the **OK** button.

*The **Settings** window closes.*
6. Click on the **Security** tab at the top of the **Internet Options** window, as shown below:

![Figure 4-5: Security Tab](image)

7. Select the **Trusted sites** option in the **Select a Web content zone to specify its security settings** section and click on the **Sites** button in the **Trusted Sites** section, as shown below:

![Figure 4-6: Custom Level for Trusted Sites](image)
The **Trusted sites** window displays, as shown below:

![Figure 4-7: Adding a Trusted Site](image)

8. At the **Trusted sites** window, perform the following actions:

   - Ensure that the **Require server verification (https:) for all sites in this zone** option is not checked.
   - Enter the URL address you use to access **AMICAS RIS** in the **Add this Web site to the zone** field and click on the **Add** button.
   - Enter the URL address you use to access **PowerScribe** in the **Add this Web site to the zone** field and click on the **Add** button.
   - Click on the **OK** button at the bottom of the **Trusted sites** window.

   *The Trusted sites window closes.*

9. Click on the **Trusted sites** option and click the **Custom Level** button in **Security level for this zone** section, as shown below:

![Figure 4-8: Custom Level Button](image)
The *Security Settings* window displays, as shown below:

![Security Settings Window](image)

**Figure 4-9: Security Settings for Trusted Sites**

10. Perform the following actions on the *Security Settings* window under the *ActiveX controls and plug-ins* section:

   - Click on the **Enable** radio button for the *Automatic prompting for ActiveX controls* option (Windows XP, SP2 only).
   - Click on the **Enable** radio button for the *Binary and script behaviors* option (Windows XP, SP2 only).
   - Click on the **Enable** radio button for the *Download signed ActiveX controls* option.
   - Click on the **Prompt** radio button for the *Download unsigned ActiveX controls* option.
   - Click on the **Prompt** radio button for the *Initialize and script ActiveX controls not marked as safe* option.
   - Click on the **Enable** radio button for the *Run ActiveX controls and plug-ins* option.
   - Click on the **Enable** radio button for the *Script ActiveX controls marked safe for scripting* option.

11. Click on the **Enable** radio button for the *Allow META REFRESH* option under the *Miscellaneous* section.

12. Click on the **OK** button at the bottom of the *Security Settings* window.

   The *Security Settings* window closes.
13. Consult your IT department to determine if you have a proxy server and how to configure it. Perform one of the following steps:

- If your IT department determines you do not have a proxy server, continue to Step 14.
- If your IT department determines you have a proxy server, perform the following and have IT configure your proxy settings:
  - Click the Connections tab in the Internet Options window, as shown below:

![Figure 4-10: Connections Tab](image)

  - Click on the LAN Settings… button in the Local Area Network (LAN) Settings section, as shown below:

![Figure 4-11: LAN Settings Button](image)
The Local Area Network (LAN) Settings window displays, as shown below. Configure this window as defined by your IT Department.

![LAN Settings Window](image1)

**Figure 4-12: LAN Settings Window**

14. Click on the Advanced tab at the top of the Internet Options window.

The Advanced Tab Settings are displayed, as in the following example:

![Advanced Tab](image2)

**Figure 4-13: Advanced Tab**
15. Perform the following actions in the **Browsing** section of the **Settings** window (the availability of some options will depend on your Operating System):

- Make sure the **Automatically check for Internet Explorer updates** option is **not selected**.
- Make sure the **Disable Script Debugging (Internet Explorer)** option is **selected**.

**If two Disable Script Debugging options are shown (Internet Explorer and Other); you only need to select the one for Internet Explorer.**

- Make sure the **Display a notification about every script error** option is **not selected**.
- If available, make sure the **Enable Install on Demand (Internet Explorer)** option is **selected**.
- Make sure the **Reuse windows for launching shortcuts** option is **not selected** (this will prevent the application from launching in a previously opened Internet Explorer window).

16. Scroll down to the **Security** section of the **Settings** window and perform the following actions:

- If available, make sure that the **Allow active content to run in files on My Computer** option is **selected**.
- Make sure the **Check for server certificate revocation** option is **not selected**.
- Make sure the **Do not save encrypted pages to disk** option is **selected**.
- If available, make sure the **Turn off automatic website checking** option under **Phishing Filter** is **selected**.

17. Click on the **OK** button to exit the **Internet Options** window.

**If the client machine is running Windows XP Service Pack 2 or higher, click on Tools and Pop-up Blocker from the Internet Explorer menu bar. If the Pop-Up Blocker Settings option is available for selection, click on it and ensure the URL address to access AMICAS RIS is in the allowed sites. If it is not, click on the Turn off Pop-Up Blocker option.**

### 4.2. Internet Explorer 7 Configuration Settings

Perform the following steps on all workstations:

1. Start **Internet Explorer**.
2. Click on **Tools** on the menu bar and select **Internet Options**, as shown below:

![Selecting Internet Options](image)

**Figure 4-14: Selecting Internet Options**

The **Internet Options** window opens with the **General** tab displayed.

3. If you are upgrading to Release 5.5 from a previous version of AMICAS RIS, perform the following:
   - Click on the **Delete…** button under the **Browsing history** section, as shown below:

![Deleting Temporary Internet Files](image)

**Figure 4-15: Deleting Temporary Internet Files**

The **Delete Browsing History** window displays.
4. Click on the **Delete files** button, as shown below:

![Figure 4-16: Deleting Browsing History](image)

*The Delete Files confirmation window displays.*

5. Click on the **Yes** button.

*The Delete Browsing History window displays.*

6. Click on the **Close** button, as shown below:

![Figure 4-17: Closing the Delete Browsing History Window](image)

*The Delete Browsing History window closes.*
7. Click on the Settings button under the Browsing history section on the Internet Options window, as shown below:

![Figure 4-18: Settings Button on the Internet Options Window](image)

The Temporary Internet Files and History Settings window displays.

8. Click on the Automatically radio button under the Check for newer versions of stored pages section, as shown below:

![Figure 4-19: Checking for Newer Versions of Stored Pages](image)

9. Set the Days to keep pages in history under the History section to 1 and click on the OK button, as shown below:
10. Click on the **Security** tab at the top of the **Internet Options** window, as shown below:

![Security Tab](image)

*Figure 4-21: Security Tab*
11. Select the **Trusted sites** option in the **Select a zone to view or change security settings** section and click on the **Sites** button in the **Trusted sites** section, as shown below:

![Figure 4-22: Custom Level for Trusted Sites](image)

*The Trusted sites window displays, as shown below:*

![Figure 4-23: Adding a Trusted Site](image)
12. Perform the following actions in the **Trusted sites** window:

   - Ensure that the **Require server verification (https:) for all sites in this zone** checkbox is not checked.
   - Type the URL you use to access AMICAS RIS in the **Add this Web site to the zone** field and click on the **Add** button.
   - Type the URL you use to access PowerScribe in the **Add this Web site to the zone** field and click on the **Add** button.
   - Click on the **Close** button at the bottom of the **Trusted sites** window.

   _The Trusted sites window closes._

13. Click on the **Trusted sites** option and click the **Custom level** button in **Security level for this zone** section, as shown below:

   ![Figure 4-24: Trusted Sites - Custom Level Button](image)

   _Figure 4-24: Trusted Sites - Custom Level Button_
The Security Settings – Trusted Sites Zone window displays, as shown below:

The Security Settings – Trusted Sites Zone window displays, as shown below:

![Security Settings - Trusted Sites Zone](image)

Figure 4-25: Security Settings - Trusted Sites Zone

14. Perform the following actions on the Security Settings – Trusted Sites Zone window under the ActiveX controls and plug-ins section:

- Click on the Enable radio button for the Automatic prompting for ActiveX controls option (Windows XP, SP2 only).
- Click on the Enable radio button for the Binary and script behaviors option (Windows XP, SP2 only).
- Click on the Enable radio button for the Download signed ActiveX controls option.
- Click on the Prompt radio button for the Download unsigned ActiveX controls option.
- Click on the Prompt radio button for the Initialize and script ActiveX controls not marked as safe option.
- Click on the Enable radio button for the Run ActiveX controls and plug-ins option.
- Click on the Enable radio button for the Script ActiveX controls marked safe for scripting option.

15. Click on the Enable radio button for the Automatic prompting for downloads under the Downloads section.

16. Click on the Enable radio button for the Allow META REFRESH option under the Miscellaneous section.

17. Click on the OK button at the bottom of the Security Settings – Trusted Sites Zone window. The Security Settings – Trusted Sites Zone window closes.
18. Click on the Internet option and click on the Custom level button in Security level for this zone section, as shown below:

![Figure 4-26: Internet - Custom Level Button](image)

The Security Settings – Internet Zone window displays.

19. Scroll down to the User Authentication section at the bottom, select the Automatic logon with current user name and password option and click on the OK button, as shown below:

![4-27: Security Settings - Internet Zone](image)
20. Consult your IT department to determine if you have a proxy server and how to configure it. Perform one of the following steps:

- If your IT department determines you do not have a proxy server, continue to Step 21.
- If your IT department determines you have a proxy server, perform the following and have IT configure your proxy settings:
  - Click the Connections tab in the Internet Options window, as shown below:

![Connections Tab](image1)

  - Click on the LAN settings button in the Local Area Network (LAN) Settings section, as shown below:

![LAN Settings Button](image2)
The **Local Area Network (LAN) Settings** window displays, as shown below. Configure this window as defined by your IT Department.

![Local Area Network (LAN) Settings Window](image)

**Figure 4-30: Local Area Network (LAN) Settings Window**

21. Click the **Advanced** tab at the top of the **Internet Options** window.

   *The Advanced Tab Settings are displayed, as in the following example:*

   ![Advanced Tab](image)

   **Figure 4-31: Advanced Tab**

22. Perform the following actions in the **Browsing** section of the **Settings** window (the availability of some options will depend on your Operating System):

   - Make sure the **Automatically check for Internet Explorer updates** option is **not selected**.
- Make sure the **Disable Script Debugging (Internet Explorer)** option is **selected**.
  
  **Tip:** If two **Disable Script Debugging** options are shown (Internet Explorer and Other); you only need to select the one for **Internet Explorer**.

- Make sure the **Display a notification about every script error** option is **not selected**.
- If available, make sure the **Enable Install on Demand (Internet Explorer)** option is **selected**.
- Make sure the **Reuse windows for launching shortcuts** option is **not selected** (this will prevent the application from launching in a previously opened Internet Explorer window).

23. Scroll down to the **Security** section of the **Settings** window and perform the following actions:

   - If available, make sure that the **Allow active content to run in files on My Computer** option is **selected**.
   - Make sure the **Check for server certificate revocation** option is **not selected**.
   - Make sure the **Do not save encrypted pages to disk** option is **selected**.
   - Make sure the **Turn off automatic website checking** option under **Phishing Filter** is **selected**.

24. Click on the **OK** button at the bottom of the Internet Options window.

   *The Internet Options window closes.*

25. If the client machine is running **Windows XP Service Pack 2 or higher**, perform the following steps:

   - From the menu bar at the top of Internet Explorer, go to **Tools** → **Pop-up Blocker**.
   - If **Tools** → **Pop-up Blocker** → **Pop-up Blocker Settings** is available, select it.
The Pop-up Blocker Settings window is displayed:

![Pop-up Blocker Settings Window](image)

- If the URL to access AMICAS RIS is not already contained in the Allowed Sites list, enter it in the Address of website to allow field and click on the Add button.
- Click on the Close button to exit the Pop-up Blocker Settings window.
- If Tools → Pop-up Blocker → Pop-up Blocker Settings is not available for selection, select Tools → Pop-up Blocker → Turn Off Pop-up Blocker.

### 4.3. Configuring How Word Documents Are Displayed

Certain parts of the AMICAS RIS application, such as Report Review, allow you to view Microsoft Word documents. Depending on how your computer is configured, these documents will either be displayed in separate pop-up windows or within the AMICAS RIS window itself.

If Word documents are displayed in separate windows, the user will not be able to see the necessary COMPLETE and CANCEL buttons at the bottom of the AMICAS RIS window until after they have closed the separate Word window. If you do not configure to open Word documents in the AMICAS RIS window, any changes will not be saved. Therefore, it is highly recommended to configure your computer so that Word documents are always displayed within the main AMICAS RIS window.

In addition, when opening transcription reports in Microsoft Word, you may be prompted to confirm the file download each and every time. It is recommended to configure your computer so that you are not prompted.
4.3.1 Configuring Word 2003

To configure how Word documents are displayed, perform the following:

1. Right-click on the Windows **Start** button and select **Explore**

   *The Start Menu displays.*

2. Select **Tools** and **Folder Options…**, as shown below:

   ![Figure 4-33: Selecting Folder Options](image)

   *The Folder Options window displays, as shown below:*

3. Click on the **File Types** tab, as shown below:

   ![Figure 4-34: Folder Options Window](image)

   *The File Types tab displays.*
4. Click on the **DOC Microsoft Word Document** option in the **Registered file types** section and click on the **Advanced** button, as shown below:

![Figure 4-35: File Types](image)

*The Edit File Type window displays:*

5. Click on the **Confirm open after download** checkbox to uncheck it, click on the **Browse in same window** check box to check it, and then click on the **OK** button, as shown below:

![Figure 4-36: Editing the File Type](image)

*The Edit File Type window closes and the Folder Options window displays.*
6. Perform Steps 4 and 5 for the following extensions on the **Folder Options** window:

- DOCHTML Microsoft Word HTML Document
- DOCM Microsoft Office Word Macro-Enabled Document
- DOCMHTML DOCMHTML File
- DOCX Microsoft Office Word Document
- DOCXML Microsoft Word XML Document

7. Click on the **Close** button at the bottom of the **Folder Options** window.

8. Close the **Start Menu** window.

### 4.3.2 Configuring Word 2007

To configure how Word documents are displayed, perform the following:

1. Right click on the **Start** button and select **Explore**.

   *The Start Menu displays.*

2. Select **Tools → Folder Options...**, as shown below:

![Folder Options](image)

   *The Folder Options window displays.*
3. Click on the **File Types** tab, as shown below:

![Figure 4-38: File Types Tab](image)

4. Click on the **DOC Microsoft Office Word 97 – 2003 Document** extension under the **Registered file types** section and click on the **Advanced** button, as shown below:

![Figure 4-39: File Types Advanced Button](image)

*The Edit File Type window displays.*
5. Select the Confirm open after download option to uncheck it, click on the Browse in same window option to check it, and click on the OK button as shown below:

![Edit File Type Window](image)

Figure 4-40: Edit File Type Window

The Edit File Type window closes.

6. Perform Steps 4 and 5 for the following extensions on the Folder Options window:

- **DOCHTML** Microsoft Word HTML Document
- **DOCM** Microsoft Office Word Macro-Enabled Document
- **DOCMHTML** DOCMHTML File
- **DOCX** Microsoft Office Word Document
- **DOCXML** Microsoft Word XML Document

7. Click on the OK button on the Folder Options window.

8. Close the Start Menu window.

On some workstations, Word 2007 will launch a separate, empty Word window when a report is pulled up that will close automatically when the report is closed. This does not cause any issues with RIS, but may be an annoyance to users. If you would like to eliminate this separate extra window, Microsoft has released a registry update to correct this. This update should not be applied unless this issue is occurring. The fix can be found at [http://support.microsoft.com/kb/927009](http://support.microsoft.com/kb/927009).
5. Optional Configuration Procedures

This chapter describes various procedures which, although not necessary, may nevertheless be desirable. These procedures are as follows:

- Configuring the windows taskbar to display multiple AMICAS RIS windows as separate items and to include the Show Desktop Quick Launch button.
- Making a desktop shortcut to AMICAS RIS for one or all users.

5.1. Configuring the Windows Taskbar in Windows XP

In Windows XP, the Windows taskbar at the bottom of the screen will sometimes group similar items together into a single button instead of displaying each item as a separate button, as shown below:

![Figure 5-1: Similar Items Grouped on Taskbar](image)

Since the AMICAS RIS application frequently requires multiple instances of Internet Explorer to be open at the same time in separate pop-up windows, this can make it difficult for newer users to navigate among the windows. Windows can be configured to always display similar items as separate buttons on the taskbar, as shown below:

![Figure 5-2: Similar Items Not Grouped on Taskbar](image)

The Windows taskbar can also be configured to show any available Quick Launch buttons on the left side, including the Show Desktop button that will minimize all open windows, as shown below:

![Figure 5-3: Show Desktop Quick Launch](image)
To configure the Windows taskbar:

1. Right-click on any blank space on the taskbar (i.e., not on one of the buttons) and select **Properties**, as shown below:

![Figure 5-4: Selecting Taskbar Properties](image)

The **Taskbar and Start Menu Properties** window displays.

2. At the **Taskbar and Start Menu Properties** window, perform the following:

   - If selected, click on the **Group similar taskbar buttons** checkbox to **deselect** it.
   - If not selected, click on the **Show Quick Launch** checkbox to select it.

3. Click on the **OK** button to close the **Taskbar and Start Menu Properties** window.
5.2. Making a Desktop Shortcut to AMICAS RIS

Rather than launching Internet Explorer and then either browsing to your AMICAS RIS website or selecting it from your list of favorites, you can instead create a shortcut on your Windows desktop that will launch Internet Explorer and automatically go to your AMICAS RIS website.

This shortcut by default will be available only to the user who is logged into the computer at the time the shortcut is created, but it can optionally be made available to all users.

To create a desktop shortcut to AMICAS RIS:

1. Launch Internet Explorer and browse to your AMICAS RIS website, either by manually entering the URL or selecting it from your list of favorites.

2. At the AMICAS RIS LogIn screen, right-click anywhere on the screen and select Create Shortcut from the pop-up menu, as shown below:

   ![Create Shortcut]  
   
   Figure 5-6: Creating a Shortcut

   A confirmation window displays, as shown below:

   ![Shortcut Confirmation]  
   
   Figure 5-7: Confirming the Shortcut Creation

3. Click on the OK button to confirm the shortcut creation.
A shortcut icon similar to the following displays on your Windows desktop (you will need to minimize any open windows to see it), as shown below:

![Created Shortcut on Desktop](image.png)

Figure 5-8: Created Shortcut on Desktop

To make the shortcut available to all users who log into this computer:

1. Right-click on the shortcut icon and select **Copy** from the pop-up menu, as shown below:

![Copying the Shortcut](image.png)

Figure 5-9: Copying the Shortcut

2. Right-click on the Windows **Start** button and select **Explore**, as shown below:

![Launching Windows Explorer](image.png)

Figure 5-10: Launching Windows Explorer

The **Start Menu** displays.
3. Navigate to C:Documents and SettingsAll UsersDesktop, as shown below:

![Figure 5-11: Exploring the All Users Directory](image)

4. Right-click on the Desktop folder and select Paste, as shown below:

![Figure 5-12: Pasting the Shortcut](image)

5. Close the Start Menu window.
6. Validating and/or Removing the Active X Version

6.1. Internet Explorer 6 Instructions

The following procedures should be performed on all workstations.

1. Open Internet Explorer.

2. Click on Tools → Internet Options…, as shown below:

   ![Figure 6-1: Selecting Internet Options]

   The Internet Options window opens with the General tab displayed.

3. At the General tab, click on the Settings button in the Temporary Internet Files section, as shown below:

   ![Figure 6-2: Internet Options Window Settings Button]

   The Settings window displays.
4. Click on the **View Objects…** button, as shown below:

![Figure 6-3: Settings Window View Objects Button](image)

The **Downloaded Program Files** window displays all downloaded objects, as in the following example:

![Figure 6-4: Downloaded Objects](image)
5. Look to see if there is a listing for the `WordActiveX.Word_ActiveX` program file, as in the following example:

<table>
<thead>
<tr>
<th>Program File</th>
<th>Status</th>
<th>Total Size</th>
<th>Creation Date</th>
<th>Last Access</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>WordActiveX.Word_ActiveX</code></td>
<td>Installed</td>
<td>312 KB</td>
<td>1/22/2005 12:00 AM</td>
<td>1/22/2005</td>
<td>2.6.0.15</td>
</tr>
<tr>
<td>Java Runtime Env. 1.3.1</td>
<td>Unknown</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>1.5.1.2</td>
</tr>
<tr>
<td>Java Runtime Env. 1.3.1.02</td>
<td>Damaged</td>
<td>None</td>
<td>1/22/2005 2:14 PM</td>
<td>1/22/2005</td>
<td>1.3.1.2</td>
</tr>
<tr>
<td>Java Runtime Env. 1.3.1</td>
<td>Installed</td>
<td>8 KB</td>
<td>1/22/2005 2:14 PM</td>
<td>1/22/2005</td>
<td>1.3.1.2</td>
</tr>
<tr>
<td>Java Runtime Env. 1.4.2</td>
<td>Installed</td>
<td>9 KB</td>
<td>9/28/2004 6:25 PM</td>
<td>9/28/2004</td>
<td>1.4.2.60</td>
</tr>
<tr>
<td>Office Update Installation Engine</td>
<td>Installed</td>
<td>32 KB</td>
<td>9/22/2004 3:05 AM</td>
<td>9/22/2004</td>
<td>11.0.6551.0</td>
</tr>
<tr>
<td>PoweractiveOK Class</td>
<td>Installed</td>
<td>45 KB</td>
<td>12/23/2003 12:46 AM</td>
<td>12/23/2003</td>
<td>2.4.6.60</td>
</tr>
<tr>
<td>Xonic MAFC File Source Filter</td>
<td>Installed</td>
<td>125 KB</td>
<td>11/11/2003 12:02 AM</td>
<td>11/11/2003</td>
<td>1.0.0.0</td>
</tr>
<tr>
<td>WordActiveX.Word_ActiveX</td>
<td>Installed</td>
<td>480 KB</td>
<td>2/14/2005 1:41 AM</td>
<td>2/14/2005</td>
<td>2.6.0.15</td>
</tr>
<tr>
<td>WMICtrl</td>
<td>Installed</td>
<td>16 KB</td>
<td>9/25/2005 1:00 AM</td>
<td>9/25/2005</td>
<td>5.4.2000.2102</td>
</tr>
<tr>
<td>XML DOM Document 1.0</td>
<td>Installed</td>
<td>1,209 KB</td>
<td>2/12/2002 2:52 AM</td>
<td>2/12/2002</td>
<td>4.0.8001.0</td>
</tr>
</tbody>
</table>

6. If `WordActiveX.Word_ActiveX` is not listed or it is listed but the version number (in the `Version` column) is **5.5.0.4**, no further action need be taken. If, however, it is listed with a different version number, do the following:

   - Right-click on the listing for the incorrect version of `WordActiveX.Word_ActiveX` and select **Remove** from the pop-up menu.
   - Exit the **Downloaded Program Files** window by clicking on the **X** in the upper right corner of the window.
   - Click on the **OK** button to close the **Settings** window.
   - Click on the **OK** button to close the **Internet Options** window.

The latest MS Word ActiveX will automatically load when you login to RIS and either View/Create a report or print something. The user must have system administrative rights to the workstation for this to occur. Contact the appropriate system administrator in your organization if your computer needs to be updated and you do not have administrative rights.

### 6.2. Internet Explorer 7 Instructions

The following instructions only apply to Internet Explorer running on Windows XP. If the workstation is using Windows Vista, refer to Section 6.3 below.

The following procedures should be performed on all workstations.

1. Open Internet Explorer.
2. Click on **Tools** → **Internet Options**..., as shown below:

![Internet Options](image1)

*Figure 6-6: Selecting Internet Options*

*The Internet Options window opens displaying the General tab displayed.*

3. Click on the **Settings** button in the **Browsing history** section, as shown below:

![Browsing History Settings](image2)

*Figure 6-7: Browsing History Settings*
The **Temporary Internet Files and History Settings** window displays, as shown below:

![Figure 6-8: Temporary Internet Files and History Settings Window](image1)

4. Click on the **View objects** button, as shown below:

![Figure 6-9: View Objects Button](image2)
The Downloaded Program Files window displays, as in the following example:

Figure 6-10: Downloaded Program Files Window

5. Look to see if there is a listing for the WordActiveX.Word_ActiveX program file, as in the following example:

Figure 6-11: WordActiveX.Word_ActiveX Program File

6. If WordActiveX.Word_ActiveX is not listed or it is listed but the version number (in the Version column) is 5,5,0,4, no further action need be taken. If, however, it is listed with a different version number, do the following:

- Right-click on the listing for the incorrect version of WordActiveX.Word_ActiveX and select Remove from the pop-up menu.
- Exit the Downloaded Program Files window by clicking on the X in the upper right corner of the window.
- Click on the OK button to close the Settings window.
- Click on the OK button to close the Internet Options window.

The latest MS Word ActiveX will automatically load when you login to RIS and either View/Create a report or print something. The user must have system administrative rights to the workstation for this to occur. Contact the appropriate system administrator in your organization if your computer needs to be updated and you do not have administrative rights.
6.3. Microsoft Vista Instructions

The following procedures should be performed on all workstations.

1. Launch **Windows Explorer** (e.g., by right-clicking on the windows **Start** button and selecting **Explore** from the pop-up menu) and navigate to the C:\Windows\Downloaded Program Files directory, as in the following example:

![Figure 6-12: Downloaded Program Files](image)

2. Look to see if there is a listing for the **WordActiveX.Word_ActiveX** program file, as in the following example:

![Figure 6-13: WordActiveX.Word_ActiveX Program File](image)

3. If **WordActiveX.Word_ActiveX** is not listed or it is listed but the version number (in the **Version** column) is **5,5,0,4**, no further action need be taken. If, however, it is listed with a different version number, proceed with the following steps.
4. Open Internet Explorer.

5. From the Tools menu, select Manage Add-ons → Enable or Disable Add-ons:

![Figure 6-14: Selecting Enable or Disable Add-ons](image)

The Manage Add-ons window displays, as in the following example:

![Figure 6-15: Manage Add-ons Window](image)
6. Select **Downloaded ActiveX Controls (32-bit)** from the pull-down **Show** menu, as in the following example:

![Figure 6-16: Showing Downloaded ActiveX Controls](image)

7. Click on the listing for **WordActiveX.Word_ActiveX** to select it and then click the **Delete** button at the bottom of the screen, as in the following example:

![Figure 6-17: Deleting the WordActiveX.Word_ActiveX Control](image)

8. Click on the **OK** button to exit the window.

The latest MS Word ActiveX will automatically load when you login to RIS and either View/Create a report or print something. The user must have system administrative rights to the workstation for this to occur. Contact the appropriate system administrator in your organization if your computer needs to be updated and you do not have administrative rights.